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Chapter 1 Installing the Software
This chapter describes how to install and set up the software.

The explanations are given below for when RIPCenter is used with the ColorPainter M-64s.

Copyright Information

Microsoft, Windows are either registered trademarks or trademarks of Microsoft.
ONYX and ONYX logo are registered trademarks of ONYX Graphics, Inc.

“ONYX RIPCenter” and “ONYX GamaPrint” are trademarks of ONYX Graphics, Inc.
PANTONE® and other Pantone trademarks are the property of Pantone LLC.
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1.1  Preparing to Install the Software
Please check the following items before installing the software.

 z Preparing the computer

The computer running the software must have the following minimum requirements.

ONYX 12 (or later versions) supports only 64-bit versions of Windows®. It cannot be installed on 32-bit versions of 

the operating system.

CPU: Intel Core i7 dual core or higher

Memory: 8 GB RAM (16 GB or higher recommended)

HDD: 500 GB or more

USB port: 2 USB 2.0 or higher ports (3 or more ports recommended)

Screen resolution: 1280 x 1024 or higher, 16-bit colors

Network: Internet connection is recommended to download patches and media profiles.

Operating system: 64-bit version of one of the following OS

 Windows® 7 Professional, Enterprise, Ultimate

 Windows® 8.1 Professional, Enterprise

 Windows® 10 Professional, Enterprise

 zConnecting the printer, preparing the license key

(1) Connect the computer and the printer with a USB cable.

(2) Insert the licence key (USB key) which is included in the Onyx software package into the computer.

* Plug & play will start, but close it.

(2)(1)
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 z Preparing the operating system

(1) Log in to the operating system with an account that has administrator privileges.

(2) If antivirus software is installed on the computer, disable it before installing RIP software

(3) Relax UAC and the other security systems for the operating system.

Procedure

Open the Start menu and then the Control Panel.

     

Check that View by: is set to Category, and then click User Accounts.

* If icons are displayed, click User Accounts.

Click User Accounts again.
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Click Change User Account Control settings.

Drag the slider to the bottom option (Never notify).

Click OK to change the setting.

If the following screen is displayed, select Yes.
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1.2  Installing the Software
Insert the installation media(USB flash drive) into the USB port.

Execute Install_ONYX.exe.

Click Open folder to view files in the installation media.

Double-click Install_ONYX.exe to start the installation.
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Click INSTALL.

Agree to the license agreement by selecting the I agree... checkbox and click Yes.

The license key driver will be installed. Click OK.

(The driver installation process will take some time.)

Program installation setup will start.
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(1) Select the installation folder.

 If there is a drive (D:) that is separate from the operating system, you are recommended installing the software 

to C:\Onyx19.

(2) Expand the name of the printer you would like to install and select media profiles you want to use.

 (Choose proper media group depending on the ink configuration (7 colors / 6 colors).)

(3) Click Install.

 (You do not need to modify the selections for Options)

The installation will start. (The program installation process will take some time.)

(1)

(2)

(3)
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When the Device Driver Installation Wizard is displayed, click Next.

When the installation has finished, click Finish.

* Depending on the operating system, a warning stating that the program is not authorized may be displayed.

 In this situation, select Install

Depending on the operating system you are using, the browser will start and a description of UAC and 

administrator privileges is displayed.

Close the window.
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The program installation is finished.

Click Finish.

RIP-Queue will automatically start.

* New versions of the driver are released from time to time.

 Regularly update the driver.

 For details about the driver update operation, see 1.5 Updating the Printer Driver.

When the RIP-Queue starts, a window prompting the user to create a myonyx account and to register the 

software is displayed. If needed, create an account to register the Onyx RIP software.
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1.3  Configuring the Port

When RIP-Queue first starts, the Configure Printer Port dialog appears.

Select (1) Custom USB and click (2) Configure.

Select (3) the displayed USB device and click (4) OK.

When the printer is correctly connected, the lamp is displayed in green.

(3)

(4)

(2)(1)
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1.4  Configuring the Media
In this section you will configure the type of media installed in the printer.

Description 

If the media installed in the printer does not match the media configured for the job, that job cannot be printed.

In the printer area, select your printer and click the setting icon of Current Media and Page Size.

Make the selection for Media Group, Media, and Page Size, and then click OK.

Automatically 
update page size

Select this box to automatically obtain the media information from the printer and use it 

to configure the settings below.

Manual Update Press this button to obtain the current printer information and use it to configure the 

settings below.

Media Group The media profiles are split into groups (like a folder) by type. Select the group here.

Example: M-64s

The media profiles contained on the RIP Center OKI Edition installation media are 

associated with one of the four media groups below.

Select the media group that corresponds to the color configuration (6 colors/7 colors) of 

the M-64s you will use. (For Vivid and Natural, see page 28)

(1) SX_7Color(Vivid) 

(2) SX_7Color(Natural)

(3) SX_6Color(Vivid)

(4) SX_6Color(Natural)

Media The media profile selection.

We recommend 1_GlossyVinyl1 as the default media.

Page Size Select the width of the media roll installed in the printer.

The size of the printable area corresponding to the selected page size is displayed in 

parentheses after the page size.
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1.5  Updating the Printer Driver
Use the Printer & Profile DL Manager program to update the printer driver.

Printer & Profile DL Manager is installed together with RIP Center.

(1) Click the Windows Start menu > RIP Center 12 > Printer & Profile DL Manager to start the program.

The screen to the left is displayed when the ONYX 

Printer & Profile DL Manager is correctly connected.

Select the following options.

- Version: Onyx19

- Manufacturer: OKI Data

- Printer: The name of your printer

- Profile Provider: Select at least one profile.

Attention

Always select the correct version. If you import a 

file with a different version, the program may not 

work correctly.

(2) Click Download Now.

(1)

(2)
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(3) Select a folder to save the file and click OK.

(4) A PrnInst file is created when the download finishes.

 Close all ONYX programs. Double-click the PrnInst file.

Reference

Depending on the network environment used, proxy settings may need to be configured.

Select Settings > Proxy Settings and configure the settings.

* Only HTTP proxies are supported.

* For the proxy settings, contact your network administrator.

(5) Select the printer checkbox and click Install.

(4)

(5)

(3)
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(6) Select Update Printer, select the 

Update Driver checkbox, and click OK.

  

(7) Click Next, and then click Finish when the installation is finished.

(6)

(7)
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(8) Click Finish.

The driver update operation is finished.

(8)
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Chapter 2 First Attempts at Printing
This chapter explains the basic workflow from starting the RIP software to printing.

RIP-QueueJob Editor Printer
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1. Start RIP-Queue.

 

Right-click the shortcut on the desktop and run as 

administrator to start RIP-Queue.

(It is recommended to check the Run this program as 

an administrator box in Compatibility setting of the 

shortcut in advance.)

2. Configure the media.

Click (1) the printer and then click (2) the setting icon of Current Media and Page Size.

A dialog like the one below is displayed.

Configure the type of media and the page size installed on the printer and click OK.

(You will select the media to print with (and the media profile that has been associated with it) here.)

(1)

(2)
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3. Open the print data.

        Click Open and select the file.

Always select the Open in Job Editor checkbox.

Select the file and click Open to start Job Editor.
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4. Configure the necessary settings in Job Editor.

Printer and Media tab

Select the type of media installed in the printer.

Here you will select the media profile with which raster image processing is performed.

* Select the type of media that matches the settings configured in 2. Configure the media.

 The job will be raster image processed even if the media does not match, but Wait for media: Media Mismatch will be 

displayed in RIP-Queue and printing will not start.

Print Mode: Select the print mode.

Color Management: The input profile and rendering intent settings.
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Preview and Size tab

As necessary, configure the settings for enlarging, shrinking, rotating, and mirroring the data.

When you change the settings, always click Apply.
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Print tab

Click Submit to send the job to RIP-Queue.
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5. Start printing

The job is raster image processed in RIP-Queue and printed with the printer.

You can edit a job in RIP-Queue once again by right-clicking it and selecting Job in Job Editor.
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Chapter 3 Useful Ways of Using the Software
This chapter explains the details about the useful features of the RIP software.
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3.1  The M-64s can be this useful and easy!

What the M-64s can do (1)

 Print with the desired colors: Freely choose between Vivid output and Natural output!

With the standard M-64s profiles included with the product,

two types of profiles, Vivid and Natural, are provided for one type of media.

(Certain types of media may only have one type of profile)

The following two color expressions can be easily realized by combining the two types of profiles and Quick Sets.

(For details, see page 51)

 z Vivid output:

When printing vector objects without color management, 

this makes vivid shading and solid filled colors possible.

Attention!

The Vivid profile must be used for Vivid output.

 zNatural output:

A printing method that provides the same color 

management for vector objects as bitmaps.
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What the M-64s can do (2)

 Print in the desired time: Control the balance of productivity and quality.

If you use the standard profiles below that are included in RIPCenter installation media, you will be able to print 

using all of the M-64s print modes.

Standard profile list
Vivid Natural

1_GlossyVinyl1 Draft Yes Yes
FastProduction Yes Yes
Production Yes Yes
Standard Yes Yes
Quality Yes Yes
High quality Yes Yes
Maximum quality Yes Yes

2_GlossyVinyl2
(For media with poor drying 

characteristics)

Draft Yes Yes
FastProduction Yes Yes
Production Yes Yes
Standard Yes Yes
Quality Yes Yes
High quality Yes Yes
Maximum quality Yes Yes

3_Banner1 Draft Yes Yes
FastProduction Yes Yes
Production Yes Yes
Standard Yes Yes
Quality Yes Yes
High quality Yes Yes
Maximum quality Yes Yes

4_Clear1 Production, high density Yes -
Standard, high density Yes -
Quality, high density Yes -
High quality, high density Yes -
Maximum quality, high density Yes -

5_BltBanner1 Production, high density Yes -
Standard, high density Yes -
Quality, high density Yes -
High quality, high density Yes -
Maximum quality, high density Yes -

6_BlueBack1 Draft Yes -
FastProduction Yes -
Production Yes -
Standard Yes -
Quality Yes -
High quality Yes -
Maximum quality Yes -

The default settings shared with all the above profiles:

 - Print Direction:  Bi-Directional

 - Move Print Head Image Width:  Selected

 - Media Advance Value:  Do not control from RIP

 - Heaters: Do not control from RIP

(These settings can be changed with Mode Options for each media print mode.)

Attention!

Switching the carriage speed and turning the color stripes on/off cannot be set from the RIP.

Configure these settings on the printer panel.
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What the M-64s can do (3)

 Print as you like:  Decrease work time with easy operation settings

The operation settings during printing (Print Direction, Media Advance Value, others) can be changed at the 

following stages.

(1) Change the default values in advance and print the data by applying the default values when creating the job.

(2) Change the operation settings for that job after creating it (after RIP, after printing).

For the value of settings that you always want to use, define them as the default values in (1). If you want to print 

with settings that are different from the defaults only for a special job, change the settings with the method in (2) 

to increase work efficiency.

(1) Changing the default values
You can change the default values in the options for each media and mode.

Example:

To check or change the draft mode default settings for the 1_GlossyVinyl1 media under SX_7Color(Vivid) media 

group

(1)

(2) (3)

(4)

(5)

(6)
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(2) Changing the operation settings for a job after creating it 
     (after RIP, after printing)

The settings applied to a job in Jobs Ready to Print can be called up and changed by right-clicking on it and 

selecting Printer Settings.

 These settings are only applied to this job.

 These settings define the operation during printing. Raster image processing of the data is not necessary a second time 

when changing these values.

(2)
(3)(1)
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3.2  Basic Operations Volume

Job Operations

 � I want to print a job again

You can print a job again by selecting it and dragging it to Jobs Ready to Print.

Jobs in Jobs Ready to Print can be 

edited again.

Select Job in Job Editor or select one 

of the following menus under Edit.

(1) Printer Settings

(2) Tiles

(3) Rotate

(1) When selecting Job in Job Editor

You can change the layout and profile 

in Job Editor. The data requires raster 

image processing again.
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(2) When selecting Printer Settings

You can change the settings such as the 

heater temperatures and printing direction 

for just the selected job. The data does not 

require raster image processing again.
* The default values associated with the 

media profile are not changed. The 

changes are applied to only this job.

(3) When selecting Tiles

When tiles are configured, you can reselect 

the tiles to print.

(4) When selecting Rotate

You can rotate the selected job freely.

Raster image processing is performed 

again automatically after you make the 

rotation settings.
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 � I want to print a job again changing the media or print mode

You can change the media (profile) and print mode for jobs in Jobs Ready to Print without opening Job Editor.

Right-click the job and select Job properties.

You can reselect the job name, media group, media name, and mode name.

(The data requires raster image processing again if one of these is changed)
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Layout

 � I want to print the job in the center of the media (rough centering)

With this method, the printing is roughly aligned with the center of the media.

To center the printing more precisely, see I want to print at the center of the media (centering) in Chapter 4 

When Problems Occur (FAQ).

Click (1) the printer name and then (2) the setting icon for Placement.

Click Center under Justification and click OK to exit.

Data that the printer receives in the future will be printed with center justification (centering).

(1)

(2)
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 � I want to print in the desired location (offset)

Click (1) the printer name and then (2) the setting icon for Placement.

Under Offset, enter numeric values for Offsets. Example: Left 20 cm, top 10 cm

In future printing, the print data will be positioned at the specified offset location.

(1)

(2)
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Media advance 
direction

Media advance 
direction

Top 10 cm

Left 20 cm

Top 10 cm

Left 20 cm

The offset can be checked in the preview.

The orientation of the RIP preview screen and the media as viewed from the front of the printer is different.

Click the arrow at the right of Print Preview to rotate the display.

(Take care with the media advance direction.)

Reference

There is a method to move the printing position on the printer as well (Origin setting mode).

Refer to the printer's instruction manual.
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 � I want to group jobs together, I want to decrease white space (nesting)

Click (1) Printer name > (2) Placement pull-down menu.

 • Group Jobs Together

The jobs are printed as a group in order from the top of the RIP data list.

 • Conserve Media

The jobs are automatically laid out in order to conserve the media.

* The jobs cannot be laid out as desired.

You can conserve even more media by selecting the setting icon for Placement > Options, and then checking the 

BestFit and Allow Rotate checkboxes.

Checking the BestFit and 
Allow Rotate checkboxes

1 1 1

2 2 2

3 3

3

(1)

(2)
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 � I want to expand the white space/spacing when copying

Click (1) the printer name and then (2) the setting icon for Placement.

Click the Options tab and entered the desired white space value in Space Between Copies.

(1)

(2)
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 � I want to print only a specified section of the job (trimming)

In Job Editor, select the Preview and Size tab.

If you place the mouse cursor at the edge of the image, the shape of the cursor will change to n.

Drag this cursor and you can freely set the trimming frame.

Click the Apply button to display the trimmed (cropped) preview.

Attention

When you will combine rotation and trimming, first rotate the image, and then trim it.
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 � I want tiling output

In Job Editor, select the Tiling tab, and then select the Enable Tiling checkbox.

If you place the mouse cursor at the right edge of the image, the shape of the cursor will change to n.

Drag this cursor to the left side and you can freely set the dividing lines.

(For a horizontal divide, drag the cursor up from the bottom edge.)
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 � I want to print only a specific tile when tiling

To print tiles individually, select the Submit tiles as separate jobs checkbox.

Click Page/Tile Setup button

The tile selection dialog is displayed. You can freely select the tiles to output.
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 � I want to print by flipping the tile so the seam shares the same side

T
he tile is ro

tated
 and

 the sid
es to

 jo
in are 

p
o

sitio
ned

 at the sam
e sid

e o
n the p

rinter.

Flip off Flip on

Click (1) the printer name and then (2) the setting icon for Placement.

Select the Flip every other tile checkbox and click OK to exit.

(1)

(2)
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 � I want to overlap the seams when tiling

* Overlapping methods

10 cm

For example, if the overlap is set as 10 cm, 5 cm overlaps are added to the right and left of the center line for a 

total overlap of 10 cm.

10 cm

If the Weld Overlap checkbox is selected, an overlap margin without ink is added.

This feature is only valid with overlaps 13 mm or wider.
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 � I want to print edge marks

In Job Editor, select the Finishing tab and select the necessary edge marks. Edge marks and crop marks can be 

used at the same time and combined.
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 � I want to insert edge, folding and/or sewing marks

In Job Editor, select the Finishing tab.

(1) Check the Enable checkbox under Custom (Sewing/Folding).

(2) Click the setting icon to display the Setup Mark Line Style dialog. Then configure the line type between 

Folding line and Sewing line, the width, the length, etc.

(3) One folding line is inserted each time you press the Add button.

(4) Use Align To to select the position of the line on the image (top, bottom, right, left), and enter the distance 

between the line and the edge of the image under Distance.

 In the example shown, the line is set at 25.4 mm from the top of the image.

 

25.4 mm

(1)
(2)

(3)

(2)

(4)
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Adjusting the Color

 � I want to print with pure colors

(1) On the Printer and Media tab, click Change Profiles to open the ICC Profile Setup dialog.

(2) Click the button to display the ICC Pure Hues dialog.

Attention

Do not use this feature with photographic images or gradations. There is a risk of the gradation breaking 

down.

(1)

(2)
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 � I want to replace colors

On the Color Correction tab, click Tools and select Color Replacements.

The dropper icon appears in the upper left.

(1) Click this icon to display the Color Replacement dialog.

(2) Click the dropper icon on the Color Replacement dialog.

(1)
(2)
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(3) Move the dropper cursor over the object you wish to replace and click.

 (In this example, the color around the tea on the tea package) The current color distribution (C34.5%, M98.8%, 

Y98.4%, K0.8%) is displayed.

(4) You can enter the desired color under Desired Color on the Color Replacement dialog. (Y100% in this example)

 When you enter a value and press the Return key, the result is reflected in the preview.

Attention

This feature is valid for all of the objects in the image, not just the object that was selected when setting the color.

In this example, the C34.5%, M98.8%, Y98.4%, K0.8% pixels of all objects will be converted to Y100%. 

When including photographic images in particular, there is a risk that the color in unintended areas will also 

be changed, so pay careful attention with this feature.
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 � I want to print with a specific spot color (spot color printing)

ONYX RIP software supports Pantone®.

(1) Open the image in Job Editor and select Job Properties in the File menu.

(2) Select PS/PDF Options under PS/PDF, and check the Use Color Table checkbox.

 

These match the spot colors (Pantone colors) applied as spot color 

swatches in Illustrator.

Attention

Enable the color management settings.

(We recommend Relative Colorimetric for the rendering intents.

If No Profile Selected is selected such as with Vivid output settings, 

color matching cannot be performed.

Pantone color samples are provided in the following folder.

Installation drive:\Onyx19\Samples\Pantone

(1)
(2)
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 � I want to properly use Vivid output and Natural output

Understand the difference between the two types of output so you can properly use them for the characteristics 

of the job.

 • Vivid output

Printed result Configuration procedure

- Thick solids
- Not muddy but pure
- Does not match the target, but vivid

(1) to (5): Configure a Vivid output Quick Set

(1) Click Edit Quick Sets  (2) Select European Vivid or US Vivid.

(3) Click Edit. (4) For the media and the mode, select the media (and print mode) 

under a media group that says Vivid.

(5) Click OK.

(6) to (8): Apply the Vivid output Quick Set and open a job

(6) Click Open. After selecting the file you want to open, specify European Vivid or 

US Vivid for (7) Quick Sets. (8) Click Open.

(6) (1)

(8)

(7)

(2)

(3)

(4)

(5)



52

 • Natural output

Printed result Configuration procedure

- Lighter solids than Vivid
- Muddy
- Not as vibrant as Vivid
- Correct color for target

(1) to (5): Configure a Natural output Quick Set.

(1) Click Edit Quick Sets

(2) Select European Natural or US Natural.

(3) Click Edit.

(4) For the media and the mode, select the media (and print mode) under a media 

group that says Natural.

(5) Click OK.

(6) to (8): Apply the Natural output Quick Set and open a job.

(6) Click Open. After selecting the file you want to open, specify European Natural 

or US Natural for (7) Quick Sets.

(8) Click Open.

(6) (1)

(2)

(3)

(8)

(7)

(4)

(5)
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Object type

Quick Set name CMYK mode bitmap CMYK mode vector RGB mode bitmap RGB vector

European Natural CoatedFOGRA39.icc CoatedFOGRA39.icc AdobeRGB1998.icc AdobeRGB1998.icc

European Vivid CoatedFOGRA39.icc No Profile Selected AdobeRGB1998.icc No Profile Selected

Japanese Natural JapanColor2001Coated.icc JapanColor2001Coated.icc AdobeRGB1998.icc AdobeRGB1998.icc

Japanese Vivid JapanColor2001Coated.icc No Profile Selected AdobeRGB1998.icc No Profile Selected

US Natural US Web Coated (SWOP) v2.icc US Web Coated (SWOP) v2.icc sRGB_IEC61966_21.icm sRGB_IEC61966_21.icm

US Vivid US Web Coated (SWOP) v2.icc No Profile Selected AdobeRGB1998.icc No Profile Selected

 • Reference: List of color management (input profile) settings for preinstalled Quick Sets

Remarks: 

For objects with specified input profiles, all of the rendering intents are set to Perceptual (Images).
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Changing the Printer Settings

 � I want to change the temperature of the heaters

Select the data in Jobs Ready to Print, right-click on it, and open Edit > Printer Settings.

Enter the desired temperatures under Heater Settings.

* The method introduced above applies the settings to only the selected data.

* The temperatures can be set in real time on the printer panel.

* The default settings can also be changed (see page 30).
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 � I want to print in uni-direction

Select the data in Jobs Ready to Print, right-click on it, and open Edit > Printer Settings.

Under Mode Options, for Print Direction, switch between Bi-directional and Uni-directional.

* The method introduced above applies the settings only to the selected data.

* The default settings can also be changed (see page 30).
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 � I want to print at the data width/I want to print at the media width

Select the data in Jobs Ready to Print, right-click on it, and open Edit > Printer Settings.

Select the Move Print Head Image Width checkbox to have the print head scan at the data width. Clear the 

checkbox to have the print head scan at the media width.

* For data width scanning, the print head moves back and forth at the widest part of the data.

 (The width that the print head moves back and forth does not change with each scan)

* The method introduced above applies the settings to only the selected data.

* The default settings can also be changed (see page 30).

* Logical seeking in the media advance direction (a feature to skip the white data portions by feeding the media) is not 

supported.
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Making Printing More Convenient

 � I always want to perform raster image processing with the same settings (Quick Sets)

Same RIP settings

- Color settings...

- Layout...

- Print mode...

Quick Sets are convenient when you want to print multiple jobs as shown in the diagram with the same RIP 

settings.

A Quick Set is a group of settings that includes color management, print mode and the such.

These settings can be automatically reflected in jobs.

When you create a Quick Set, a hot folder with the same name is also created.

If image files are directly put in this folder, they can be printed with the settings automatically applied to them.

- Scale to 1000%
- Target is SWOP...

Setting A Setting B Setting C

- Clear vinyl
- High density printing...

- High quality printing
- 16-bit processing turned on...

This allows you to print jobs without changing the settings for each job. This is convenient when printing a large 

amount of jobs using the same settings because you do not need to configure the settings for each job in Job 

Editor.

The next page introduces the methods for creating and using Quick Sets.
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Creating a Quick Set

* If a job is open in Job Editor, close Job Editor.

(1) In the Printer area, click Configure Printer, 

select the Quick Sets tab, and click New….

(2) Give the Quick Set an easy to understand 

name such as the media name, print mode, 

purpose, or the name of the person who will 

use it.

 The settings that are saved here will be 

automatically applied to jobs.

(3) In the advanced options, you can further 

configure the settings.
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Selecting a Quick Set

 • From RIP-Queue

When you open data from RIP-Queue, the settings for the selected Quick Set can be applied to that data.

 • From the printer driver

A created Quick Set can also be selected from the PostScript driver and those settings can be applied to the data.

 • Hot folder

A hot folder was also created with the same name as the Quick Set. By directly putting PDF files and EPS files into 

this folder, the data can be registered as a job in RIP-Queue with the Quick Set settings applied.

Path name: 
C:\Onyx19\Input\printer name\Quick Set name
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 � I want to know about ink usage and cost

* If a job is open in Job Editor, close Job Editor.

As advanced setup, perform steps (1) through (5).

(1) In the Printer area, select Configure Printer.

(2) If the warning above appears, click Yes.

Select the Ink Calculation tab.

(3) Select the resolution (print mode).

(4) Select $ for the reporting unit.

(5) Enter the cost of ink per cc in $ / Milliliter (in the example above, $0.25/ml).

* Colors are displayed for ink cartridges that are not installed in the printer (for example, S1, S2, S3). These can be left as 0.

* The settings must be configured for each combination of resolution and density (HD stands for high density). When using all 

of the print modes, configure the settings for all of the resolutions in the Resolution column.

When you are finished configuring the settings, click OK.

(1)

(3)

(4)

(5)

(2)
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This section shows you how to configure the 

settings to calculate the amount of ink used for 

individual jobs.

(6) Open the data from RIP-Queue.

 (Open the data in Job Editor)

(7) Select the Print tab and click Print Setup.

Select the Output tab and select the Calculate Ink Usage 

checkbox.

When you finished configuring the settings, click OK to exit.

* When you always want to calculate the amount of ink, selecting the Calculate Ink Usage checkbox in the advanced options 

for the Quick Set is convenient.

 For details, see Creating a Quick Set on page 58.
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(8) Click Submit.

 (The cost of ink is displayed after raster image processing.)

(9) The ink usage and cost is displayed at the end of the job information in Jobs Ready to Print.

Attention

The calculated ink usage is only the amount used for printing.

It does not include the amount of ink consumed by color stripes or auto cleaning.

The amount of ink that is ejected during printing also varies slightly due to the environment temperature.

Therefore, use the displayed values as a rough guide.

Move the slider to the right edge.
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* If the ink usage is not displayed when moving the slider to the right edge, use the following procedure.

Right-click on the job information display area and select the checkboxes for Ink Use (milliliters) and Total Ink.

You can also select other types of information for display by selecting the different checkboxes.
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 � I want to print from an application

The printer driver below is located in Printers and Faxes or Devices and Printers in the Windows Control Panel.

Select the printer from the application's print menu, configure the necessary settings, and click the print button.
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 � I want to use a new media profile

Many ColorPainter media profiles have been prepared for you on the ONYX download site. These profiles may be 

used by anyone at no charge.

Obtaining profiles

Downloading ONYX profiles using DL Manager

To download profiles, use a program called Printer & Profile DL Manager.

Printer & Profile DL Manager is installed together with RIPCenter.

Click the Windows Start menu > All Programs > RIP Center 19 > Printer & Profile DL Manager to start the 

program.

 

   

The screen to the left is displayed when the printer 

is correctly connected.

- Version: Onyx19

- Manufacturer: OKI Data

- Printer: The name of your printer

- Profile Provider

Select the media profiles you want to install.

Attention

Always select the correct version. If you import a 

file with a different version, the program may no 

longer work correctly.

After you select the profiles, click Download Now.
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Select the destination folder for the file and click OK to start the download.

When the download is finished, a PrnInst file is created.

See Importing profiles on page 67 for the method to import profiles from the PrnInst file.

Reference

Depending on the network environment used, proxy settings may need to be configured.

Select Settings > Proxy Settings and configure the settings.

* Only HTTP proxies are supported.

* For the proxy settings, contact your network administrator.
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Reference: Importing profiles

This section explains how to import media profiles (files with the extension OML).

* If a job is open in Job Editor, close Job Editor.

(1) In RIP-Queue, select Configure Printer.

 If the warning above appears, click Yes.

(2) Select the Media tab and click Import.

(3) Select a file (extension .OML and .PlnInst), 

select the checkboxes, and click Import.

(4) When the imported media appears in the RIP-Queue media field, have the procedure is finished.
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 � I want to reinstall the RIP

If for whatever reason you must reinstall the RIP, follow the steps below.

(1) Backup your settings

On the RIP-Queue File menu, select Manage Printers. If the warning to the right appears, click Yes.

Select the printer and click Create PrnInst.

The printer driver, media profiles, and the Quick Sets can be saved together.

Select the necessary items and click Next.



69

Save a file with the extension PrnInst.

You will browse for this file later, so specify an easy to remember location and click Save.

Reference: When you want to back up the jobs in RIP-Queue

Save all of the files in \Onyx19\Work\OKI ColorPainter M-64s to a different location.

Note: Select the folder with the name of your printer in the Work folder.
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(2) Uninstall the RIP

   

Shut down all the ONYX applications that are running.

Open the Start menu and then the Control Panel.

Check that View by: is set to Category, and then click Uninstall a program.

* If icons are displayed, click Programs and Features.

Select RIPCenter 19 -> Uninstall/Change.

The uninstaller will start. Click Yes to uninstall the program.

After the software has been uninstalled, delete the \Onyx19 folder.

(3) Install the RIP
Follow the installation steps in Chapter 1 to install the RIP software.

After the software has been installed, exit all ONYX software, and double-click on the PrnInst file that was used 

for the backup in (1) to update the driver and add the media.

If you saved the jobs, put them back to the original location.
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 � I want to change the display time for warnings/errors

(1) In RIP-Queue, select Configure Printer.

 If the warning above appears, click Yes.

(2) Select the Media tab, select 

the media group and media 

that you want to configure, 

and then click Options.

* The settings must be configured for 

each media.

(3) Click Edit Setting.

(4) You can set the display time for warnings/errors.

 (For the details of each setting, refer to the description on the window of the setting.)
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Printing Faster

 � I want to reduce raster image processing time

You can increase the speed of raster image processing by changing the bit depth.

Use 8-bit processing Jobs are processed with 8-bit processing. The processing is high-speed, but 

highlights in gradations may not be expressed smoothly.

Use Smart 16-bit processing

(Default value)

Only jobs that include gradations are processed with 16-bit processing.

Other jobs are processed with 8-bit processing.

Use 16-bit processing Jobs are processed with 16-bit processing.

Modification procedure

(1) In Job Editor, open the Print tab and click Print Setup.

(2) The Process/Print Setup dialog will appear. Select the Output tab.

(3) Under Bit Depth located at the bottom right, select the number of bits for rendering.

* If you always want to perform raster image processing with the same bit depth, configuring it in the advanced options for 

the Quick Set is convenient.
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 � I want to heat the heaters before I start printing (CP_Manager setting)

Set the printer to the online state, then start CP_Manager on the computer.

Select the Heater Settings tab and set the temperature for each heater.

Select Always and click Update at the bottom right.

The printer will raise the temperature immediately, and after it reaches the set temperature, it will continue to 

maintain that temperature.

* Heater temperature operations are also possible on the printer panel.
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 � I want to hold a job submitted to RIP-Queue

 • Per-job setting

Open Job Editor and select the Print tab. Click Print Setup and select the Hold for Operator checkbox on the 

Workflow tab. Click OK to exit the setup dialog.

 • To set all jobs to always be held during registration

In RIP-Queue, open the edit dialog in the Edit Quick Sets dialog. Under Operator Instructions, select the Hold 

for Operator checkbox.
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The jobs in Jobs Ready to Print will be held for printing. Right-click on a job and clear the Hold check to start 

printing.
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 � I want to add specific information to a job

(1) Select a job and open Job Properties.

(2) Select the Job Ticket in Print.

(3) Add information to the job.

 You can add information such as Job Number, Company Name, Customer Name, Custom01, Custom02, and 

Notes.

 You can use the information you have added with the job search function explained below.
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 � I want to search a job

Enter keywords to display only the jobs that meet the search conditions.

Enter search conditions 

such as the following:

  - File name

  - Job ticket content

  - Printer name
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Contour Cutting

 � Creating a file for cutting

Create an EPS or PDF file that will be used for cutting with an application such as Adobe Illustrator.

Select Spot Color for the color type that will be used for the cut path and enter a name.

This name will be set for the name of the cutter path prefix in the quick set.

 � Configuring a quick set

Start RIP-Queue and select Edit Quick Sets.

Select a cutter in Contour Cutter Selection under Cutter Options, and check the Use Cutter Path Prefix box.

Enter the same name as the one you entered for the spot color during cut path creation.

* When this setting has been configured, cut data is sent to CUT-Server the same time print data is sent to the printer.

Configure the other parameters as required.
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 � Configuring CUT-Server

Starting CUT-Server opens a window used to add a cutter.

Select a cutter in the pull-down menu.

The name of the selected cutter is displayed in the field at the left of the window.

Click the gear icon at the right of the cutter name.
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Select a port in the pull-down menu under Port Settings, and click Setup.

Set the port configuration.

 � Printing and Cutting

Open the file used for cutting in Job Editor.

Check that the correct cutter is selected and send the data.
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Click the Print Now button in RIP-Queue.

Cut data is sent to CUT-Server at the time print data is sent to the printer.

Configure the required settings for the cutter and click Cut Now.
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Chapter 4 When Problems Occur (FAQ)
This chapter explains how to deal with common problems.
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Operation Problems

 � The data cannot be sent (1)

The printer cannot print when it is offline.

Action

If the lamp icon at the top right of RIP-Queue is green, the printer is normally connected and in the online state.

If the lamp icon is red, the printer is in the offline state. Click the lamp icon to set the printer online.

 z If the printer does not go online...

Check the printer connection.

(1) Check that the USB cable is correctly connected.

(2) Check that the printer panel display is PRINTER READY.

(3) Perform a USB device scan.

Procedure

With Configure Printer, open the Device 

tab, select the printer, and click Configure 

Port.

* When the Server will shut down message is 

displayed, select Yes.

Select Custom USB and click Configure.

Run ReScan, select the device, and click OK 

when the device is displayed.
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 � The data cannot be sent (2)

The printer is online, but Wait for media: Media Mismatch is displayed and the job cannot be printed.

Action

The media type selected in the job and the media type configured for the printer in RIP-Queue do not match.

In RIP-Queue, check the type of media selected in the job.

Click (1) the printer and then click (2) the setting icon for Current Media and Page Size.

Select the same media as is selected in the job and click OK to exit.

(1) (2)
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 � A RIP error occurred and the job cannot be printed

Cause 1: Security lock

The PDF file has a security lock function applied to it such as a password.

If you attempt raster image processing on the file with the security lock engaged, an error will occur.

PDFs can be set with a password to open the document.

(EPS does not have this option.)

Action

Open the application software that created the file, disable the security lock, and save the file again.

Perform raster image processing on the saved file once again.

Cause 2: Swatches are the cause

You may not be able to perform raster image processing when using transparency effects in swatch patterns 

created with old versions of Illustrator (Ver. 7 or earlier).

Action

First rasterize the swatches causing the problems in Illustrator, then save the file again.

Perform raster image processing on the file that was saved again.
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 � The job is automatically printed when raster image processing is performed

After raster image processing, the job is automatically printed without being queued.

Action

Check Automatically start printing.

Click (1) the printer and then click (2) the setting icon for Placement.

Uncheck the checkbox of Automatically start printing and click OK.

(1)

(2)
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Layout Problems

 � The image was trimmed

When printing the job, the edge of the image is missing.

Action

Check the width of the data and the page size.

Attention: There are areas that cannot be printed on at both edges of the page (deadspace)!

For example, if the media is 54 inches wide (1372 mm), you cannot print a job using the full 54-inch page size.

There is always a deadspace of a few millimeters at both edges.

The value for this deadspace changes according to the presence of color stripes and the edge guard.

Printable area = Page size - Deadspace

 zCalculating the area that can be used for printing

Edge guard Color stripes Printable width Remarks

Yes No Page size - 20 mm *

Yes Yes Page size - 43 mm

No No Page size - 10 mm

No Yes Page size - 33 mm

* The internal page size sets the width that can be used for printing with these conditions.

When you want to print a job that uses the full width of the media, you must lay out the job taking into 

consideration the deadspace.

The next page introduces how to set a custom page size.
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Reference: Setting a custom page size

You can set the desired irregular page size.

* If a job is open in Job Editor, close Job Editor.

(1) In RIP-Queue, select .

 If the warning above appears, click .

(2) Select the Page Sizes tab and 

click Add.

(3) Enter Name, Width and Height  then 

click .

(4) The registered page will appear in the 

RIP-Queue page sizes field.

* Even if you use a different name, you cannot use two or more custom page sizes with the same width and height.

 (The custom size can be registered, but it cannot be selected when used)

 In this situation, slightly change the height.
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 � I want to print at the center of the media (centering)

The size of the deadspace, where the printer cannot print (print data is trimmed), changes depending on the color 

stripes and edge guard settings of the printer (see the table below).

The following settings are required to print at the center of the media (centering) in order to prevent print data 

from being trimmed.

(1) Custom page size

(2) Justification

(3) Edge guard compensation

When color stripes are ON, the maximum width of the print data for which centering can be used becomes 

smaller than the width of the paper set in custom page size (see the table below).

Type
Printer settings Dead space RIP settings required to use centering Max. print data width for  

which centering can be usedColor stripes Edge guard Cap side Maintenance side Paper width set in custom page size Justification Edge guard compensation

A ON Used 10 32.6

Media width – 20.0 mm Center ON

Media width -65.2 mm
B ON Not used 5 27.6

C OFF Used 10 10 Media width -20.0 mm
(Same as paper width set in  

custom page size)D OFF Not used 5 5

(1) Custom page size

Remove 20 mm from the width of the media that will be used.

Example: 1371.6 mm (media width) - 20.0 mm = 1351.6 mm (paper width that must be set)

Set this value as the paper width in custom page size.

Set the length of the rolled media under Height.

       * See page 88 for how to configure custom page sizes.

Click the gear icon next to Current Media and Page Size, and select the custom page size that you have 

configured under Page Size.
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(2) Justification

 Click the gear icon next to Placement, and select Center under Justification.

 

(3) Edge guard compensation 

 Right-click on the job data, select Edit, and then select Printer Settings.

 

 Check the Edge Guard Compensation box.

 

 The settings are completed.

 The printer will print the data at the center of the media.
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Color and Quality Problems

 � When I print the job, an area with a different color appears (color stitch)

When printing a job, an area with a different color may occur around effects such as transparencies and drop 

shadows. (See the diagram below)

Cause

The RIP may not be able to process advanced effects such as shading and drop shadows, so when the data is 

saved as an EPS file in Illustrator, it is automatically rasterized (turned into an image). If the RIP rendering intent 

settings for raster and vector are different, a difference in colors will occur between raster and vector objects.

Take the following action.

Action

Configure the input profile and the rendering intents as the same setting for both raster and vector.

In Job Editor, on the Printer and Media tab, click Change Profiles.

   

On the Profiles tab, set the image (raster) and vector input profiles to the same setting.

On the Rendering Intents tab, set the image (raster) and vector settings to the same setting.

Same setting Same setting

Same setting
Same setting
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 � The vector data colors are not vivid

There is no vividness in the colors in vector objects, or the colors are weak.

Cause

When color management is performed on the vector objects, the colors will lose a good portion of their 

vividness.

Action

Turn off color management for vectors.

Procedure

In Job Editor, on the Printer and Media tab, click Change Profiles.

On the Profiles tab, set the vectors to No Profile Selected.

You can also turn off color management for specific hues.

For details, see I want to print with pure colors on page 47.
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 � Problems with data that includes gradations

I can see differences in the expression of highlights in gradations and they are not smooth. (See the diagram 

below.)

Cause

The smoothness of gradations depends on the processing bit depth on the RIP side. When the job is processed 

with 8-bit processing, highlights may not be expressed smoothly.

Action

Use 16-bit processing.

Procedure

In Job Editor, open the job and select the Print tab. Click Print Setup and select the Output tab

to display the dialog below.

Select Use 16-bit processing for the bit depth.
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 � The preview in Illustrator and the printed result are different

Text that is in the image in Illustrator disappears when printed. (See the diagram below) Or a solid filled color that 

should not be there has appeared.

Illustrator preview Printed result

Cause

The Illustrator overprint effect is the cause.

Action

Disable the RIP overprint setting.

Procedure 1: Change the default setting

On the RIP-Queue Setup menu, select RIP Configuration > Configure Adobe RIP.

Select the EMULATEOVERPRINT checkbox and click Edit. If you set Configuration Value to NO, the overprint 

effect is disabled.
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Procedure 2: Configure individually for each job

In Job Editor, open the job and select (1) Job Properties… in the File menu. Select (2) Adobe Rip Options under 

PS/PDF, check the Override Default RIP Settings checkbox, and then click the Settings... button to display the 

dialog shown below.

Select the EMULATEOVERPRINT checkbox and click Edit. If you set Configuration Value to NO, the overprint 

effect is disabled.

(1)

(3)

(2)
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Reference: What is overprinting?

Overprinting is an effect that expresses two or more overlapping objects with a color that mixes the base and the 

object color.

Overprinting off Overprinting on

The original purpose was to serve as a function to prevent misregistration. Misregistration is when a white gap 

occurs due to mechanical problems with precision when, for example, inked text is placed on top of a dark color. 

(See the diagram below)

This is called misregistration and it is a typical problem in the printing industry.

Example of misregistration

Overprinting demonstrates its effectiveness when you want to fill in this gap. There are no problems with dark 

colors as shown in the diagram, but when white is mixed with the base color, it becomes the same as the base 

color, which causes problems to occur such the white text disappearing as was previously mentioned.
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 � Noticeable banding/lines

Check the following items in order. For even more detailed methods of dealing with problems, refer to 

Troubleshooting in the printer's instruction manual.

(1) Check that the print head nozzles are not clogged.

 - Print a nozzle print.

 - If there are missing nozzles, register the nozzle number in SNM (smart nozzle mapping).

(2) Check that the media advance value is correct.

 - Perform a media advance adjustment (by automatic advance adjustment or manual advance adjustment).

 - When specifying the media advance value on the RIP side (media profile mode options), the specified value on 

the RIP side has precedence over the adjustment value found by the adjustment on the printer side.

 Check that the specified value on the RIP side is the adjustment value for that media.

 * (For example, even for the same adhesive vinyl,) The optimal media advance value differs for each media product.

  Always perform an adjustment for each media product.

(3) Try decreasing the heater temperatures.

 For faintness or white lines, the cause may be that you are using a media product where the ink dots have 

difficulty spreading. Try lowering the temperature of all three heaters by 5°C.

 (When you change the heater temperature, change the media advance value again).

(4) Try increasing the heater temperatures.

 For black lines, the cause may be that you are using a media product where the ink has difficulty drying.

 Try raising the temperature of all three heaters by 5°C.

 (When you change the heater temperature, change the media advance value again).

(5) Try printing in uni-direction.

 When the cause is the difference of the order of ink being released going back and forth due to bi-directional 

printing, this can be resolved with uni-directional printing.

(6) If you are using the Natural profile, try switching to the Vivid profile.

 For solid filled portions in particular, printing is performed by restricting the ink when using the Natural profile, 

so the filling of solids will tend to be weaker compared to the Vivid profile.  Try switching to the Vivid profile.

(7) Switch to a higher quality print mode.

 Switching to a higher quality print mode is effective for all of the causes listed above.
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Chapter 5 Feature Dictionary
This chapter describes the various settings in Job Editor.
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Printer and Media

This tab is where you select the media profile and print mode.

Media Group, Media Name, Print Mode

These reflect the values set in RIP-Queue.

Color Management

The settings for the profiles and rendering intents are grouped here.

Profiles

The profiles that are the target for color matching.

When No Profile Selected is selected, color matching is not performed.

Vectors can express vibrant colors, so we recommend No Profile Selected.

Rendering Intents

Perceptual (Images): Emphasizes brightness and the quality of gradations. This is often applied to photographic 

images.

Relative Colorimetric: Emphasizes color reproducibility. The media color is not simulated.

Absolute Colorimetric: Emphasizes color reproducibility. The media color is simulated.

Saturation (Graphics): Emphasizes saturation. This is often applied to solid filled colors.

PosterColor: CMYK is expressed relatively, RGB is expressed perceptively.

Output

Import external profiles and advanced black generation here.
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Preview and Size

This tab is where you make simple adjustments to the layout such as scaling, rotating, and cropping the data.

Maximum Print Area

This reflects the page size set in RIP-Queue.

Width/Height/Magnification

Scales the print data. Click  to adjust the width/height ratio.

Crop Size

With the origin as the top left of the screen, this shows the position in coordinates of the cropping frame.

If you put the mouse cursor on the edge of the print data, the cursor shape changes to and the cropping frame 

can be freely set within the area of the image.

Image Setup

These options rotate or mirror the image.

PS/PDF Setup

These settings are enabled with formats that have pages (PostScript, PDF).

These settings are disabled with raster formats such as JPEG and TIFF.

Page Num

If the data has multiple pages, you can specify the page.

Enlargement

Enlarges or shrinks only the page size.

A value larger than 100 shrinks the page size. A value smaller than 100 enlarges the page size.

Crop Outside Page

Discards the data outside of the page size.

Swap Width & Height

Swaps the width and height of the page size.

Original PS/PDF Settings

This button restores the modified page size settings to their original settings.

Apply

Click this button to apply the settings. Always click this button before submitting the job.
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Tiling

This tab divides the print data.

Enable Tiling

Select this checkbox to activate the tiling feature.

Submit tiles as separate jobs

Select this checkbox to submit one tile as one job to RIP-Queue.

(The actual selection work is done on the Print tab.)

Column/Row (Number of Tiles)

Specify the number of tiles in the columns and the rows.

Width/Height (Default Tile)

The width reflects the area that can be printed on for the page size that is configured in RIP-Queue. The height is 

50 m.

Column/Row (Custom Tile)

These show the tile numbers. Vertical is the column, horizontal is the row, and the count starts from the top left of 

the screen.

Width/Height (Custom Tile)

These show the size of the tile. The values can also be entered here.
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Tile Overlap Marks

The overlap (margin) setting.

Zero-Line Marks

Settings for printing a black crosshair with a white inner portion in the middle of the tile overlap area. 

Reset All Tiles

Click this button to reset all of the tiling settings.

* For the actual procedures, see page 41 to 44.
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Color Correction

This tab is where you perform color correction.

(1) Primary Color Levels

You can adjust the saturation for each channel by moving the saturation sliders right and left.

Do not set the values extremely high (or low), set the values in the center range.

You can make finer color adjustments by using the primary color curves.

(2) Color/Gray Levels

You can adjust Contrast, Brightness, and Saturation for color images and Highlights, Midtones, and Shadows 

for grayscale.

(2) (3) (4)

(1)

(5)

(7)

(8)

(6)
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(3) White/Black Limits

You can clean up an image without modifying the contrast.

Use these settings to clean up data that has been scanned with a scanner.

(4) Color Replacements

You can replace the colors in data in Job Editor.

(5) Named Color Replacement

You can replace the colors of the name colors.

(6) Sample Point

You can display the information regarding the color where the cursor is currently positioned before and after the 

color correction.

(7) Primary Color Curves

You can modify the amount of ink printed at any specific level.

(8) Filter

You can apply a color correction filter to the image.

The operations to create, delete, import, or export filters can be found in Filter Manager on the File menu.
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Finishing

You can set Edge, Sewing, and Folding Marks on your image.

Edge Marks

Selects the edge marks at the four corners of the image.

Edge marks and crop marks can be used at the same time and combined.

Custom (Sewing / Folding)

Sets folding lines (sewing lines). Press the setting icon to make detailed settings for the lines.

The lines can be placed freely at the top, bottom, right and left of the image. To combine multiples lines, press 

Add and then configure Align To and Distance.

Print Label

Sets the labels that can be added next to the image during printing. Click Setup to configure the content of the 

labels.

Contour Cutting Paths

Sets whether or not to configure the contour cutting paths at the time of tile setup.
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Print

This tab is where you send the data from Job Editor to RIP-Queue.

Copies

Specify the number of copies to print.

Hold for Operator

The job is held until the operator selects to print the job.

To start printing, right-click the job in RIP-Queue and clear the Hold check.

Print Setup

Workflow: Settings related to handling the job in RIP-Queue.

Output: Settings related to the output method.
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Job Ticket

When using RIP-Queue with lots of saved jobs, you can add information to the jobs as labels to identify each 

customer.

Submit

This button sends the data to RIP-Queue.
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Media Profiles for M-64s

Standard profiles to use as generic profiles are stored on the printer driver included with the M-64s. If the media 

you are using does not have a dedicated profile, refer to the descriptions in the table below and use one of the 

standard profiles.

Media profiles Description

1_GlossyVinyl1 -  For media that is not banner vinyl such as white vinyl with adhesive, synthetic paper, and textile 

media, first select this media profile.

2_GlossyVinyl2 - For media where the ink tends to bleed, mottle, or coalesce when using 1_GlossyVinyl1, use this 

media profile.

- The amount of ink is set lower than 1_GlossyVinyl1.

3_Banner1 - Select this media profile for banner vinyl.

- If you are concerned with bleeding with this media profile, try using 2_GlossyVinyl2.

4_Clear1 - When using clear vinyl and translucent white vinyl in backlit applications, use this media profile.

- Only a high density mode profile has been prepared.

- We recommend using High quality, high density mode.

Profiles with even faster modes have been prepared, but they use a large amount of ink, so 

blocking easily occurs when wound.

Fully evaluate the media that will be used before using this profile.

5_BltBanner1 - When using backlit banner vinyl, use this media profile.

- Only a high density mode profile has been prepared.

- We recommend using "High quality, high density" mode.

Profiles with even faster modes have been prepared, but they use a large amount of ink, so 

blocking easily occurs when wound.

Fully evaluate the media that will be used before using this profile.

6_BlueBack1 - When using blue back paper, use this media profile.

- Generally, coated papers for solvents dry poorly, so this media profile is set to reduce the amount 

of ink.

- In the standard profiles, this one restricts the amount of ink the most.

For media that does not dry and cannot be wound with 1_GlossyVinyl1, 2_GlossyVinyl2, or 3_

Banner1, try using this media profile.

With the standard M-64s profiles included with the product, there may be two types of profiles, Vivid and 

Natural, provided for one type of media.

The following two color expressions can be easily realized by combining the two types of profiles and Quick Sets.

(For details, see page 51)

Vivid output: Natural output:

By printing vector objects without color management, 

this makes vivid shading and solid filled colors possible.

Attention!

Vivid output requires using the Vivid profiles.

A printing method that provides the same color 

management for vector objects as bitmaps.
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16-bit Rendering and 8-bit Rendering

This setting is related to the accuracy of processing gradations. If data is processed at 16-bits, the gradations 

can be cleanly printed, but during raster image processing, 16-bit processing takes longer than 8-bit processing. 

If the data that contains no gradations is processed at 16-bits, the quality will not improve, only the RIP time will 

increase.

Therefore, we recommend using Smart 16-bit processing to automatically determine whether or not the data 

contains gradations.

Use 8-bit processing The processing is high-speed, but highlights in gradations may not be 

expressed smoothly.

Use Smart 16-bit processing

(Default value)

Only jobs that include gradations are processed with 16-bit processing.

Other jobs are processed with 8-bit processing.

Use 16-bit processing Jobs are processed with 16-bit processing.
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CP_Manager

CP_Manager is a software installed on the computer to control the printer.

If you use CP_Manager, you can quickly access the information you want, and operate the printer in an easy to 

understand manner.

The installation program and instruction manual are stored on the CD-ROM that is included with your printer, so 

please make use of them.
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Introduction 
 

This document describes the workflow related to the contour cutting function of the ONYX 19 software. 
 

What is contour cutting? 
 

Contour cutting is a function used to cut a printout following the contour of an image or an object using a 
cutter after an image file has been printed. (This can be used for example to cut stickers of manga 
characters printed on adhesive media.) 
 

The general workflow of contour cutting is as follows. 
 
1. Creation of an image file containing cut paths (lines for cutting) using spot colors in an application such 

Adobe Illustrator. 
2. Printing of the image file using RIP-Queue. 
3. When the printing in RIP-Queue starts, a cut file is generated, and then the file is sent to and saved in 

CUT-Server. 
4. Installation of the printout in the cutter, and necessary operation and configuration of the cutter. 
5. The cut file is sent from CUT-Server to the cutter, and the printout is cut. 
 
 
 
Note: How does the ONYX RIP software identify (detect) cut paths? 
 
 The ONYX RIP software identifies (detects) spot colors with a particular name in an image file as cut 

paths. 
These spot colors (the name of the spot colors) allow the cutter to identify the cutting locations. 
The ONYX RIP software checks the presence and name of spot colors when a vector file, such as PDF, 
EPS and PS, is opened in RIP-Queue. 

 The name specified for the spot color must match the name of the cut path prefix specified in RIP-
Queue. 
By default, the ONYX RIP software searches for spot colors beginning with the prefix “CutContour”. 

 

This prefix can be customized by the user. 
 When the name of the spot color begins with the cut path prefix, all the paths using the corresponding 

color are extracted from the image and the color is used to define the contour cut file. 
RIP-Queue processes the spot color as a cut path to generate the cut file for the cutter, and then sends 
this file to CUT-Server. 

 Multiple spot colors can be used to specify different cutting methods. 
However, all the spot color names used must begin with the same prefix. 
For example, with an image containing two spot colors named “CutContour A” and “CutContour B”, the 
ONYX RIP software will identify both colors as cut paths. The two different names will be identified 
separately in the cut file, as well as in CUT-Server. 
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Defining a cut path in Adobe Illustrator 
  

Explanations are given using Adobe Illustrator, but similar procedure applies with other graphics editor 
software, such as Corel DRAW. 
 

Cut path definition 
 

The first step to design an image file for contour cutting is to create a spot color. 
  

To specify spot colors for cut paths in Adobe Illustrator 
 
1. Open Swatch Palette. If you cannot find Swatch Palette, select Swatch from the Window menu. 

2. Click the arrow at the top right corner of the Swatch Palette to display the secondary menu and select 
New Swatch... to display the New Swatch... window, or click the New Swatch... icon in the Swatch tool 
bar. 

 

3. In the New Swatch window, enter the name of the swatch color used for contour cutting. 

 

The name must begin with the prefix defined in RIP-Queue. 
When only one spot color is used, the name is the prefix only. (The default prefix used in ONYX RIP is 
“CutContour”.)  
Multiple cut path types (cutter settings) can be identified separately by using multiple spot colors with the 
same prefix. 
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4. Select Spot Color from the Color Type drop-down menu. 
Use the slider bars to create a CMYK color. 

The CMYK color specified here defines the color displayed in the preview on the monitor. 

* Since the spot color section is not printed together with other sections of the image when RIP-Queue 

prints the image file, it is recommended to specify a color that can be easily identified to make sure 

that the color is recognized in RIP-Queue. (It is then easier to identify the cause when a problem 

occurs with the path detection during the RIP process execution.) 

 

 

5. Click OK to close the New Swatch window. 

 
  



 

4  

To define a cut path in Adobe Illustrator 
 
1. Open the file in Adobe Illustrator. 

2. Select Window > Layers > New layer... to create a new layer, and select the Layers tab. 

 

3. Draw the cut path using the Rectangle/Ellipse, Pen or Pencil tool. 
The spot color is specified with Fill or Stroke. Therefore, check that all the paths are closed.  

 

* Use Fill instead of Stroke when the file output at the end is EPS. 
 Use also Fill when it is PDF. (Errors may occur if Stroke is used.) 

 
After adding the cut paths to the image, move the cut path objects to the top layer or to the first object in the 
object order. Ideally, create a new layer, move it to the top level, and then move all the cut path objects to 
this new layer. 
 

1. Click the Create New Layer button on the Layers window and enter a name. 

2. Select all the cut path objects from the files in the Layers window. 

3. Drag all the cut path objects to the new layer. 
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 Placing the cut path objects above the rest of the image makes it possible to prevent the occurrence of 
potential problems during cut path detection. 

 
 It may not be possible to add cut path objects to the new layer depending on cut path location. 

The cut paths are detected without problems when they do not come across artworks. 

 

 By default, EPS files do not take artboard size into consideration, but the artwork location is taken into 

consideration. 

In Illustrator, the Save as window contains a Use Artboards checkbox. 

This setting can be used when the file type is set to EPS. 

Check this box if the artboard size needs to be taken into consideration. 

When Stroke is used for cut path When the Fill is used for cut path 

   

 Artboard size in PDF files is taken into consideration. Ideally, jobs should be saved in PDF version 1.6 
or later. 
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RIP-Queue settings 
 

Before printing a contour cut file, it is required to modify an existing quick set or to create a new quick set. 
(This can also be done manually in Job Editor.) 
There are two settings that must be activated in the quick set. 

 

・ Cutter path prefix setting 

・ Contour cutter selection 
 

To create a new quick set for contour cutting: 
 

1. In RIP-Queue, select the printer you want to use, and click Configure Printer. 

 

2. In the Configure Printer window, click New at the right of the Quick Sets tab. 
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3. Check the Use Cutter Path Prefix box. 

 

4. In the text box, enter the spot color prefix name specified for the cut path in Illustrator or another 
software application. 

・ This is the name of the prefix that the ONYX RIP software will search for when spot colors are 
detected in the image file.  

・ You may modify the default name “CutContour” if required. 

・ Any name can be entered for the spot color specified as cut path as long as it begins with the 
prefix specified here. 

5. Select the cutter you want to use in the Contour Cutter Selection drop-down menu. 
(“Generic Cutter” is selected in this example.) 

6. When you have finished configuring the quick set, enter a name and save the set. 
(The name is “Cutting workflow” in this example.) 

7. Click the Open button in the toolbar, and select a job.  
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8. Check that the newly created quick set is selected before opening the job. 

 

9. After the job has been RIP processed, print it using the printer. 

   

* Although the cut file for CUT-Server is created just after the printing has started, it is not always 
required to launch CUT-Server during printing. (The cut file is automatically saved in the hot folder.) 
When CUT-Server is launched just after the printing has started, the created cut file is displayed below 
the cutter name.  

 
Note: The following message is displayed if an image with no cut path is printed with contour cut selected. 

 

 

 

 

 



 

9 

 

 
Modifying the cutter setting: 
 
You can right-click on the job and select Job Properties to modify the cutter assigned to the print job. 
In the Job Properties window, you can select a new cutter or select None to disable the cutter marks. 

 

 
Cutter assignment and job nesting: 
 
Group Jobs Together can be selected only for job to which the same cutter has been assigned. 
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Cutter mark settings: 

1.  Select Manage Cutters... from the File menu in RIP-Queue, and click Yes to stop the server.  

   

2. Select the cutter you want to use, and click Configure.... (“Graphtec Cutter” is selected in this example.) 
The options that can be used differ depending on the cutter and the cutter marks. 
In this step, printing of ONYX barcode can be disabled. 

   

 
* Unchecking the box for the cutters you do not use disables the display of these cutters in the 

Contour Cutter Selection drop-down menu in job properties or in Job Editor. This may be useful to 
prevent the user from selecting the wrong cutter (cutter marks). 
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Contour cut using Job Editor 
 

The same steps as in RIP-Queue can be performed manually in Job Editor. 

 

1.  Click Open in RIP-Queue. 

 

2. Select a job, check the Open in Job Editor box, and click Open. 

 

3. Select a cutter in the Contour Cutter Selection drop-down menu in the Printer and Media tab. 

(“Graphtec Cutter” is selected in this example.) 

 

4. Select Job Properties... in the File menu. 
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5. Select PS/PDF Options and check the Use Cutter Path Prefix box. 

 

6. Enter the prefix name (“CutContour” by default). 

7. Click OK. 

8. Click the printer icon to send the job to RIP-Queue. 

 

9. After the job has been RIP processed, print it using the printer. 

   

* Although the cut file for CUT-Server is created just after the printing has started, it is not always 
required to launch CUT-Server during printing. (The cut file is automatically saved in the hot folder.) 
When CUT-Server is launched just after the printing has started, the created cut file is displayed 
below the cutter name.  

 
 

 



 

13 

CUT-Server 
  

CUT-Server is an application used to send the created cut file to the cutter. 

 

CUT-Server can be launched from the RIP-Queue toolbar or from the Windows Start menu. 

   
 

* CUT-Server can be launched independently without using an USB dongle.  
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CUT-Server interface: 
 
The CUT-Server interface consists of four sections: 
(1) Toolbar (at the top of the screen) 

Used to open the cut files, change the settings and execute the other basic operations. 
When the application is launched for the first time, CUT-Server displays the Add Cutter window. 

(2) Cut File Area (at the left side of the screen) 
Displays all the cutters and the cut files currently used in CUT-Server. 
You may select the file currently being worked with to use the cutter area. 
A different window is opened for each cutter. 

(3) Cut Preview (at the center of the screen) 
Displays the outline of the currently selected cut file. 
You can zoom in and out this preview with the zoom buttons at the top of the section. 

(4) Cut File Tools (at the right of the screen) 
You can use these tools to rotate the cut file. 
You can also select the cutter setting to be used and configure the cut layers. 

 

 

 

  

- 
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The Toolbar contains the following options. 

 

 

 

・ Used to open a cut file created with ONYX RIP or an SVG file. 

・ To manually open a cut file, click Open on the toolbar, and select the cut file. The 
extension of the cut files that are recognized is .xml. 

・ Use this option when the cut file you want to use is saved on a network or in a different 
location.  

 

・ Used to save the changes made to the cut file currently selected in the cut file list. 
 

 

・ A barcode reader can be used to select the cut job. 

・ The correct job can be selected in CUT-Server by scanning the barcode on the printout. 

・ Follow the steps below to import a cut file in CUT-Server using Scan a Bar Code.  
1. Click the Scan a Bar Code button on the main toolbar. 
2. Enter the barcode in the input field, or scan the barcode using a barcode reader. 
3. Click OK. 

 

 

・ Deletes the selected cut job. 

 

・ When using CUT-Server, a lot of cut files may be displayed at the same time in the cut 
file area. 
You can make this area neater by sending (saving) old cut files to the archive. 
Even after being deleted from the CUT-Server cut file area, the files can be restored 
from the archive. 

・ To automatically send the cut files to the archive after the cutting has been performed, 
select Preferences > Jobs > Archive jobs after cutting. 

・ The Archive window contains the list of cut file names for each cutter. 
Select a file and click Restore File(s) to restore the file to the cut file area and use it again. 
Select a file and click Delete File(s) to delete the file from the archive. 
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・ Used to add, remove or configure cutters. 

・ The list of cutters is displayed in the device management section in the cutter window.  

 

Add Cutter 

Click the Add Cutter button to add a new cutter. 
Delete Cutter 

Select a cutter and click Delete Cutter to remove a cutter from the list. 
Configure 

Select a cutter and click Configure to configure a cutter. 

 

・ Used to further configure CUT-Server. (See below for details.) 

・ These settings include the addition of the hot folder location used to automatically load 
the cut job. 

 

・ Used to open a Web browser and access ONYX online help site. 
 

 

 

Preferences details 
 

・ The application appearance and functions can be customized in the preferences. 

・ Select a window between Appearance, Cutters, Jobs, and Shortcuts. 

・ You may also see information about the version in About. 

・ To configure the preference settings, click Preferences in the toolbar on the main screen, and then 
select an option. 

 
(1) Appearance 

The Appearance window is the first window displayed in Preferences. 
Configure these settings to modify the general appearance of the application. 

 

 Ruler enabled 

Activate this setting to display the ruler at the top and left side of the preview screen. 
 Display warning when deleting cut file 

Activate this setting to display a confirmation message when deleting a cut file. 
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 Show feed direction on the preview 

Activate this setting to display an arrow showing the feed direction at the top of the preview screen. 
The arrow shows the direction of the media when the cut job has been rotated. 

 Animate cut paths 

Activate this setting to display the cut paths with animated dotted lines. 
 Language 

This setting displays the current user interface language. 
Use the drop-down menu to select a language. 
After selecting a language, you will be prompted to restart the application to apply the change. 

 Units 

This setting displays the measurement units. (The ruler unit can be changed between meter and inch.) 

 
(2) Cutters 

Used to manage the cutters. 

 

The check box Sort cut paths and Allow open cut paths are displayed in the Applications Settings of the 
Cutters window. 
 Sort cut paths 

This setting is activated by default. 
Sorting cut paths using a logical method that reduces the media cutting adjustment during cutting 
makes it possible to increase cutting precision and efficiency. 

 Allow open cut paths 

With this setting, the cutter leaves the open paths as they are and does not return to the cutter starting 
point. 

This guarantees an error margin when creating the cut paths. 
 
(3) Jobs 

This window displays the Archive Options and Hot Folder settings. 

 

Archive Options 

 Don’t do anything with jobs after cutting. 

With this setting, the jobs are kept in the job list until the cut file is deleted manually. 
A cut file can be deleted from the job list by selecting a job and clicking Delete from the right-click 
menu, or by clicking the Delete icon on the toolbar. 
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 Archive jobs after cutting. 

With this setting, the jobs are moved automatically to the archive list. 
Jobs from the job list can also be archived manually by selecting a job and clicking Archive in the 
right-click menu. Archived jobs can be restored or deleted using the Archive icon on the toolbar. 

 Delete jobs after cutting. 

With this setting, the jobs are deleted from the list after cutting. 
 

Hot Folders 

CUT-Server recognizes automatically the cutter hot folders and displays a list of custom hot folders from 
the network or another location. Hot folders are also displayed in the job list for the cutter assigned to the 
cut file. 

When RIP-Queue processes the image file, a cut file is created and automatically saved in the hot folder 
for the corresponding cutter. 

 

Check the boxes to activate the corresponding hot folders. 
 Add 

Used to create a custom hot folder so that CUT-Server will recognize a folder on the network or 
another location. 
To add a custom hot folder, click Add and select a location. 

There is no limit in the number of hot folders that can be added. All the cut jobs inside the specified 
hot folders are displayed in the job list. 

 Edit 
To edit a hot folder in the list, select a folder and click Edit. 

Editing a folder allows you to select a new location for the folder. 
 Remove 

To remove a hot folder from the list, select a folder and click Remove. 

 
(4) Shortcuts 
Select the Shortcuts icon to display the shortcut keys. 

The shortcuts are only displayed and cannot be edited. 
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(5) About 

Select About to display information about CUT-Server. 
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To add or configure a cutter in CUT-Server: 
 
1. When you start CUT-Server for the first time, you are prompted to select a cutter using the drop-down 

menu. 

 

2. After selecting the cutter, click OK. (“Graphtec CE6000” is selected in this example.) 

 

3. Select the connection port in Port Settings and then click Setup. After configuring the selected port, 
click Close to close the window. 

(A list of devices is displayed when using USB connection. In this case, select a cutter and click Close.) 

   

* Auto-forwarding 
When Auto-forwarding is selected, cutting is performed automatically after the cut job has 
been received in the queue. 
After cutting, the job is sent to the archive. 
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- Set the IP address for TCP/IP 
- Set the correct COM port for serial communication 
- Check that the cutter is recognized with USB communication 

     

TCP/IP          Serial    USB 

In Configuration, you can configure presets defining the settings, such as Cut Job Settings, Cut 
Layer Settings, cutter force and cutter speed, depending on the cutter you are using. 
Since the settings depend on the cutter you are using, add new settings when necessary. 

   

4. The name of the cutter being used is displayed at the left side of the screen. 

 



 

22  

5. When an image file is printed with RIP-Queue, the cut file is displayed automatically below the name of 
the cutter at the left side of the CUT-Server screen. (Cut files will accumulate with each printing.) 

 

6. Select a cut file and click Cut Now. 

Data is transferred and the cutter starts. 

When data is being processed, operation by the user may be required depending on the cutter. 

 

All the cut jobs created on the CUT-Server main screen are displayed on the left side. 
Settings such as Rotation, Registration Mark Detection and cutter configuration can be added to these 
jobs. 
The available settings depend on the cutter being used. 
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Using layers 
 
The Layers section is contained in the lower part of Cut File Tools at the right side of the CUT-Server screen. 

 

 Each job contains at least one layer. 
By default, only one layer is automatically created for a cut job. 

 Depending on the source file and the RIP-Queue application settings, a cut job may contain multiple 
automatically generated layers. 
When one or more colors are used for spot color in the cut path definition, CUT-Server creates a layer 
for each spot color. 

 Layers provide a means to manage the order in which cut paths are sent. 
The path in the top layer is cut first, and the path on the layer below is cut next. 

 Each layer can be turned on or off. 
Turning a layer off only makes the path in that layer inactive and does not delete the path. 
Uncheck the box next to Layer to prevent the path from being sent to the cutter. 
This is convenient for cutters that do not support multiple cut settings such as Through Cut and Kiss Cut. 

 

 If two spot colors are used in CutContour Kiss and CutContour Thru path definitions, two layers are set 
by default for the cut job. 

 The path defined with the first spot color is set in the first layer, and the path defined with the second 
spot color is set in the second layer. 

 When the custom setting uses the same name as the spot color, the custom setting based on the spot 
color name is automatically assigned to each layer. 
Said differently, if you want to automatically apply a specific cutter setting selection to a layer, set the 
same name for the cut layer as the cutter setting. 
For example, let’s say there are the two spot colors “CutContour Kiss” and “CutContour Thru” in an 
image, and the same names “CutContour Kiss” and “CutContour Thru” are set as custom settings to 
CUT-Server. 
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Then, when the cut job is loaded in CUT-Server, the custom setting with the same name is assigned for 
the layer containing the path for CutContour Kiss, and CutContour Thru is used for the second layer. 
When no cutter setting matching the cut layer name is selected, the default cutter setting for the layer is 
selected. 

 
Cut path and layer management: 
 
Cut paths can be moved to a different layer by selecting a path and dragging it to the layer information panel. 
You may also right-click on a path and assign it to a layer. 

 

Click a path to see to which layer the path is assigned. 
The layer information panel to which the path is assigned is highlighted. 
You can also see which cut path is assigned to the layer by clicking on the layer information panel. 
The layers can be activated or deactivated using the checkboxes on the layer information panels. 

 
The Add a New Layer, Rename the Selected Layer, Move the Layer Up/Down and Delete the Selected 
Layers icons are located at the bottom of the Layers section. 
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Adding a new layer 
1. Click the Add a New Layer icon at the bottom of the Cut File Tools panel. 

 

2. Enter a name for the layer and click OK. (The layer is named “Layer 1” in this example.) 

 

3. Select a cutter setting for the new layer. 

 

4. Add cut paths to the new layer. 
 
Renaming layers 

1. Select the layer information panel of the layer you want to rename. 
2. Click the Rename the Selected Layer icon at the bottom of the Cut File Tools panel. 

 

3. Enter a new name for the layer and click OK. 

 

 

Moving layers up and down 

1. Select the layer information panel of the layer you want to move. 
2. Click the Move the Layer Up or Move the Layer Down icon at the bottom of the cut file tools panel. 

 

 
Deleting layers 
1. Select the layer information panel of the layer you want to delete. 
2. Click the Delete the Selected Layer icon at the bottom of the Cut File Tools panel. 

 

3. Click OK. 
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When the cutter being used does not support multiple layer cutting: 

 
CUT-Server provides a means of cutting individual layers with different settings. 
Some cutters do not support multiple settings in CUT-Server. However, sometimes jobs need multiple cutter 
settings regarding cutter force and speed. In such a case, Cut-Server layers can be used to solve this issue. 
 
1. The procedure is explained below with a cut file containing two layers. 

 

 
2. Create cutter custom settings. (The settings “CutContour1” and “CutContour2” are created in this 

example.) 

   

  



 

27 

3. Select a created cutter setting from the Setting pull-down menu for each layer. 

 

 
4. Uncheck the box of one layer, and click Cut Now. 

 

The paths of only the checked layer (“CutContour1” in the example) are cut. 
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5. Change the layer selection and click Cut Now. 

 

The paths of only the checked layer (“CutContour2” in the example) are cut. 

 
  



 

29 

When the cutter being used supports multiple layer cutting: 
 
A different cutter setting, such as cutting force and speed, can be configured and selected for each layer 
listed in the Cut File Tools section, allowing the user to perform one cutting operation with different settings. 
 
1. First, create the required custom settings. (The settings “CutContour1” and “CutContour2” are created in 

this example.) 

   

2. Assign a setting to each layer and then perform the cutting operation. 
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Generating a cut file without printing the image again 
 
When you could not obtained a cut file after a successful printing: 

 
You can generate a cut file without printing the image again. To do so, you need to set the printer to be used 
to Print to File instead of connecting to the printer. 

 
1. In RIP-Queue, select Configure Printer and click the Device tab. 

 

2. Click Configure Port… and then select Print to File. 

 

3. Click OK to return to the main window. 

4. Drag the image from the buffer area to the job in the print area without processing the image again. 

5. Click Print Now. RIP-Queue will not physically print the image but will output a small file on the 
computer and process the cut file. 

6. Do not forget to return to the first setting window and to reestablish the connection to the printer. 
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Performing cutting only in CUT-Server 
 
 You can perform only the cutting operation by created cut paths defined by a SVG file. 
 SVG files can be created using a vector based application such as Adobe Illustrator, Corel and 

Inkscape. 
 The design procedure varies depending on the graphics editor application. 
 

 
Designing a file with Adobe Illustrator, Corel, Inkscape or other vector graphics application: 

 

 All the vector paths contained in the final SVG file are cut paths. 
 The paths are not defined by spot colors or object order. 
 The image must be displayed in wire frame mode to verify the cut paths. 

 
 Additional operations may be required before exporting the file as an SVG file to create a file for cutting 

only. 
All the fonts that will become outlines must be converted. 
The fonts that will remain as text may not be rendered correctly. 
Convert all the fonts that must become outlines before exporting the file as an SVG file. 
It is recommended to save the job as a text design file before converting the fonts to outlines. 

 

 Vector graphics applications provide functions to modify the appearance of objects, but they do not 
directly affect paths. 

These functions include grouping of objects with rounded corners or overlapping objects. 

Additional operations are required when using these functions. 

Path simplification, combination or scaling may be required. 

Paths will be redefined based on the modified appearance of objects. 

 

 Do not use Transparency or Overprint. 

Transparency effect or overprint is not required in the design file to perform cutting only. 
 

 Do not use Outline Stroke unless it is part of a section you want to print. 
Outline Stroke will generate two cut paths. 
Paths exist at each side of the stroke. 
The cut path will not follow the original path of the stroke but the stroke shape. 
In some cases, the stroke becomes an outline when the object is scaled. 
In such a case, delete the stroke before scaling the object. 

 Some applications handle multiple types of SVG file. 
For example, Inkscape handles Inkscape SVG and Plain SVG. 
Use Plain SVG in ONYX RIP. 
Inkscape SVG files will not work properly in CUT-Server.  

Glossary 
 

SVG: Abbreviation of Scalable Vector Graphics and open standard file type. 
 This is a XML-based file type containing vector graphics. 
Vector: A type of graphics using mathematical expression to define points, curves, and shapes. 
 The advantage of vector graphics is that the image can be magnified with no pixelation. 
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Importing SVG files to CUT-Server: 
 
1. Click Open in CUT-Server. 

2. Select the cutter you want to use in the Select a cutter drop-down menu at the right of the Open 
window. 
(“Graphtec CE6000” is selected in this example.) 

 

3. Select an SVG file and a cutter, and then click Open. 

4. After the job has been loaded, it is displayed at the left of the screen. Click the job at the left of the 
screen to verify the cut paths. 
The settings for cutting only files are displayed in the Cut File Tools panel. 
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5. The Rotation, Mirroring, Scale, Gaps and Setting for Cut Job settings are displayed. 
 

・ The Rotation settings can be set by 90° increments (90, 180, 270). 
Since registration mark detection is not required with cutting only jobs, all rotation settings can be 
used with all cutters. 

・ Mirroring loads the cut design and flips it around a vertical axis. 
Activate this setting to apply mirroring to the cut design. 

・ Scale is used to adjust the size of the cut job. 

Scaling without keeping the image ratio can be performed by clicking the “link” icon next to Width and 
Height. 

Image scaling applies to all copies displayed in the cut nest preview. 

・ You can specify the number of copies using X Copies and Y Copies. 
There are also the X Gap and Y Gap settings next to copy setting. 
These settings are used to increase the gaps between each copy. 

 

・ Setting and Layers are displayed below the Copies settings. 
The available settings depend on the cutter being used. 

 
6. After configuring the cutting only job, click Cut Now to send the job to the printer. 

The cutter starts cutting after confirmation. 
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Troubleshooting 

Issues Possible causes Solutions 

The error 
message “The 
file contains no 
cut paths” is 
displayed during 
printing. 

1. The spot color name does 
not use the correct prefix. 

2. The color used to define 
the path is not a spot 
color. 

3. Transparency effect is 
rasterized in the EPS file 
and the cut paths have 
been cleared. 

4. The cut paths are below 
the artwork in the design 
file. 

1. Check the prefix of the spot color name in the 
quick set. 
Pay attention to the capitalization of the first letter 
and spaces. 

2. Check that the swatch in the graphics application is 
set to spot color and not to process color. 

3. If transparency effect is used, the file must be 
saved in PDF version 1.6 or 1.7. 
Transparency effect is not supported by EPS files 
and is rasterized. 

4. Move the objects defined as cut paths to the first 
object in the object order or to the top layer. 

CUT-Server 
does not open. 

An incorrect version of JAVA 
is installed. 

Close all ONYX® applications. 
Go to My Computer > ONYX X19 folder and delete the 
Vendor folder as well as the Vendor folders in the CUT-
Server, Media Manager, and Xrip folders. 
Then run a repair of the install.  

The cut file is 
not created. 

1. RIP and Print on the fly 
is enabled. 

2. Two Stage Processing or 
Antialiasing is enabled. 

3. The cut paths are not 
detected. 

1. Disable RIP and Print on the fly. 
This setting prevents the cut file from being created. 
In Job Editor, go to the Print tab and click Print 
Setup.... 
In the Output tab, uncheck the RIP and Print on 
the fly box. 

2. Disable Two Stage Processing and Antialiasing. 
These settings prevent the cut file from being 
created. 
In Job Editor, select Job Properties in the File 
menu. 
Two Stage Processing is in PS/PDF Options, and 
Antialiasing is in Jaws Options. 

3. Check that the cut paths are in the top layer and 
that the spot color name contains the prefix defined 
in the quick set. 

The cut file has 
been created 
but is not 
displayed in 
CUT-Server. 

1. Incorrect cutter marks are 
used. 
Only valid cutter marks 
are displayed 
automatically below the 
cutter name. 

2. Spot data is a process 
color and not a spot 
color. 

3. Cutters marks are not 
selected in RIP-Queue. 

4. Full read/write 
permissions are not 
enabled for the user or 
the hard drive. 

1. Check that the correct RIP-Queue marks for the 
cutter being used are selected. 
Cutter marks must be changed in RIP-Queue and 
the job must be printed again to use the correct 
marks for the cutter. 
When using the remote CUT-Server station, check 

that the cut files are in the RIP computer selected in 
the Job section. 

2. Check that the design data for the cut path colors 
in the graphics application are spot colors and not 
process colors. 

3. Check the buffered file in RIP-Queue to ensure that 
cutter marks are enabled. 

4. Log in as a local computer administrator, or change 
the folder permissions for full read/write function. 

The wrong cut 
file is displayed 
in CUT-Server. 
- Lines are not 

in the right 
place in the 

cut file. 
- Cut lines are 

missing in the 
cut file. 

The USECUTSPLINES 
setting is enabled. 
Some cutters do not support 
the CUTSPLINES setting. 
The cut file cannot be output 
correctly because of this. 

1. In RIP-Queue, go to Setup > RIP Configuration > 
> Configure Jaws (or Adobe) RIP.... 

2. Check the USECUTSPLINES OFF box. 

3. RIP process and print the job again. 
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Clicking Cut Now 
does not do 

anything. 

The cutter is connected but 
has not been configured. 
This error occurs when the 
communication between the 
cutter and the computer has 
not been configured 
correctly. 

Check that the connection is correct in Port Settings. 
Configure the cutter communication. 
1. Click Manage Cutters. 
2. Select a cutter and click Configure. 

3. Select the correct port setting (USB, Serial, 
TCP/IP, etc.) and click Setup. 

4.  Enter the necessary information and click Close. 

You may also click the gear icon next to the cutter 

name to configure the cutter. 

I-Cut or Zund cut 

files are not 
displayed in CUT-

Server.  

These devices are driven 
from the manufacture 

software, not CUT-Server. 

Open the cut file created with ONYX RIP in the cutter 
folder with the current manufacturer software. 

I can see cut data 
in Preflight. 

1. The setting Use Cutter 
Path Prefix is not 
enabled. 

2. Spot data is a process 
color and not a spot 
color. 

1. In RIP-Queue, check that Use Cutter Path Prefix 
is enabled in the quick set being used 
(Advanced... > PS/PDF Options tab). 

2. Check that the design data for the cut path in the 
graphics application is spot colors and not process 
colors. 

 
 

Glossary 
die cutting Cutting all layers of a laminate.   

kiss die cutting Cutting only the surface layer with adhesive in a laminate. 
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Cutting the contour 
 
This section explains the procedure to cut the contour on a printed media using Graphtec CE6000. 
 
When printing a PDF containing cut paths after selecting a cutter (“Graphtec Cutter” in this example) from the 
Contour Cutter Selection pull-down menu and with Use Cutter Path Prefix checked under Cutter Options 
in RIPCenter, the printed image is surrounded by registrations marks, triangles showing the print direction 
and the name of the cut data file. 

The number of registration marks varies depending on the size of the printed image. 
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Set the media in the cutter so that the triangles are facing the front. 

 

 

Check the name of the cut data file printed next to the triangles. The name is “1AQFZZ16AIT” in this 
example. 

 

 

Use the arrow buttons of the cutting plotter to move the cutting tool inside the right-hand registration mark on 
the front. 
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Select “1AQJFZ…” of the file displayed below the cutter name in Cut-Server, and click Cut Now. 

 

The cutting plotter detects automatically the registration marks and starts cutting the contour.  
 

This ends the cutting procedure. 
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